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1.0 Purpose 
The purpose of this document is to provide AHLTA clinical team members and trainers with various tips 
and hints concerning the use of AHLTA. The information contained in this document can be used to 
facilitate the use and incorporation of AHLTA into your day-to-day activities. This document is not a 
static document and as we learn more about the system and its place in the MTFs, we will add additional 
tips. For more information on a specific topic or module, please consult the full AHLTA User’s Manual 
or the online help located in the Help menu of the application. 
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2.0 AHLTA How To’s 

2.1 Lab Result Filters 
By now you may have noticed that many patients have a large number of lab results. AHLTA pulls lab 
results from CHCS from roughly two years prior to activation to the present. 

AHLTA can quickly filter these results to display only the lab results in which you are interested. You 
may have already set the time filters to only look for results for a specific time period, such as results 
from the past 30, 60 or 90 days. 

You can create additional filters for specific groups of lab tests, such as glucose, Hemoglobin A1C and/or 
Potassium test results. When the Lab Results Filter is used, only the specified test results are displayed. 

To create a Lab Results Filter: 

1. With the Lab module open, click Options in the upper right corner of the workspace. The Lab Results 
– Properties window opens. 

2. Click the Filter tab and select the Specific Labs radio button. 

 
Lab Results – Properties Window 

3. Click Add. A list of lab tests to add to your filter will display. It takes approximately 30 seconds to 
bring up the list of all the tests. Because of the mapping requirements for multiple AHLTA sites, you 
will notice that there are multiple entries for the same test. Highlight the tests you want to put into 
your filter. These filters give you the ability to put multiple tests, such as Glucose and Hemoglobin 
A1C or Urine Microalbumin and urine protein, on one filter. Just ensure you select all of the tests of 
each kind so your filter will display all the necessary results. 
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4. Highlight the test in the left pane and click Add. Notice that the highlighted test moves over to the 
right pane.  Insure you pick up all similar tests to get the results from all AHLTA sites. I our example, 
you should select all the Hemoglobin A1C tests to get the needed results. 

 
Filter Lab Tests Selections List 

5. When you have added all of your tests, click OK. You are returned to the Filter tab of the Lab Results 
– Properties window and your selected tests are displayed. 

 
Lab Results – Properties Window 

6. Click Save As to name your filter and save it. 

7. Enter the Filter name and click Save. The filter is now available for use in the Lab module. 
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8. Click the Filter drop-down list and select the filter. When you select a filter, the lab test results 
contained in the filter are displayed in the upper-half of the workspace. Highlight a test to display the 
results in the lower-half of the workspace. 

 
Filter Drop-Down List 

 

The same concept applies to the radiology exams in the Radiology module. Radiology filters can be set up 
to display only the different kinds of Chest x-rays, or all the foot and ankle x-rays. The screens are a little 
different in the Radiology module, but the same basic steps apply. 

2.2 Graphing Vital Signs 
AHLTA gives you the ability to display and print graphs of a patient’s vital signs data. The blood 
pressure, heart rate, height, weight, respiration, temperature and O2 saturation data can be displayed in 2-
dimensional and 3-dimensional graphs. 

To graph vital signs: 

1. Open the Vital Signs Review module. You can also open the Vital Signs module from an open 
encounter and click the Review tab. 

2. Select the set of vital signs you want to graph by performing a left-click and dragging your mouse 
over the data you want to graph. Graphing can only be done on columns adjacent to each other. 
Columns can be moved or dragged next to each other to allow for graphing. For example, you can 
drag the WT column next to the BP column so you could graph BP and weight only. Columns can 
also be sorted to group data together by clicking on the column header. 

 
Vital Signs Review Module 

3. Click Graph Vitals on the Action bar. The highlighted data will be displayed in a graph. 
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Graph Vitals Window 

4. You can display the graph in different basic formats by selecting the graph type from the Chart Type 
area. The values of each point will display by default, this can be turned off by de-selecting the 
checkbox labeled Show data point values. Individual data points can be removed by de-selecting 
them in the Vital Key area. 

5. A hard copy can be printed by clicking Print. The patient’s name will appear on the print out. 

6. You can also insert your graph in your encounters by taking a screen shot for placement into the Add 
Note section of your encounter. By using the Master Graphics Excel program, you can place and crop 
a screen shot of your Vital signs graph to get your encounter. See the tip on the steps for performing 
this function. 

2.3 Viewing a Trend with Lab Results 
AHLTA allows you to display patient lab results in a specific way to help you better detect any trends in 
the data. 

To view a trend with lab results: 

1. Open the Lab module and select the test you want to review. 
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2. Select the Display All Results for the Selected Tests checkbox. All results for the specific test are 
displayed. 

 
Lab Module 

3. Select the Horizontal radio button to group the test results in columns. Any trends of individual tests 
can be easily spotted by scrolling up and down, as necessary. 

 
Lab Module 

2.4 Inserting Pictures into an Encounter 
It has been said that a picture is worth a thousand words. These pictures can be inserted into the Add Note 
section of your encounter. 

1. With an encounter open, click Add Note on the Action bar. The Select Note window displays. 

 
Select Note Window 
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2. Click New Note. The Encounter Note window opens. 

 
Encounter Note Window 

3. Click Load File. The Select Destination File window opens. 

 
Select Destination File Window 

4. Navigate to and select the image and click Open. The Image Preview window displays. 

NOTE:  Image files must be in either .bmp or .tif format and must be less than 500K in size. 

5. Click Select. The image is placed into the Encounter Note window. 
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Encounter Note Window 

6. Click Note Complete. The Encounter Note window closes and the Note, with the image, is added to 
the Add Note area of the electronic SF600. 

2.4.1 JPG Files 
One of the most common formats for photos is the Jpeg (.jpg, .jpe) format.. Jpeg images cannot be 
directly imported into AHLTA. If you have a .jpg image you would like to use, The simplest way would 
be to load it into ms PowerPoint or the Master Graphics Excel program so you can paste the image into 
the Add Note section of your encounter . With in PowerPoint, Click on Insert ->Picture -> From File. 
Locate and load the image and it will display. Select the image and copy into your clipboard memory 
(Click on the copy button, Click on Edit -> Copy or CTRL C). Bring up AHLTA and your encounter.  
Open your Add Note box and Single click in the lower area. Then Paste the image by using a CTRL V or 
Right click and select paste.  

NOTE:  If pasting from PowerPoint, insure your image isn’t too wide. Wide images can be cut 
off on the right. 
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2.5 Printing Lab and Radiology Results 

2.5.1 Printing Lab Results 
Lab results can be printed from the Flowsheets module. 

To print lab results: 

1. Open the Flowsheets module. 

2. Click the drop-down list in the upper, right corner of the Flowsheets module and select Lab Results. 
The patient’s lab results populate the workspace. 

 
Flowsheets Module Drop-Down List 

3. You have two options for printing lab results: 

a. Click Print Entire Flowsheet to print the entire list of lab results. 

b. To print only a portion of the lab results, drag select the portions of the lab results you would like 
to print. Notice that the Print Flowsheet Portion button becomes enabled. Click Print 
Flowsheet Portion. 

 
Print Flowsheet Portion Button 

2.5.2 Printing Radiology Results 
Radiology results can be printed directly from the Radiology module.  

To print radiology results: 

1. Open the Radiology module. 

2. Select the radiology report you want to print. 

3. On the File Menu, click File, then Print and then select Rad Result. 

 
Radiology Module File Menu 
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2.6 Why Can’t I Sign My Encounter? 
Each encounter begins as an appointment. Each appointment is assigned to a specific provider. It is the 
assigned provider or owner of the encounter that must sign off on the entire documented encounter note. 
If you are taking care of an encounter (or Telephone Consult) for another provider, you must transfer the 
encounter to yourself, in order for you to sign it. At times, the assigned provider cannot sign an encounter.  

There are several electronic requirements to sign an encounter. These include: 

• At least one diagnosis, 

• A disposition, and 

• An E&M code. 

NOTE:  Telephone consults do not have a disposition so  this  is not  required  for a Telephone 
Consult. 

Additional factors impeding the assigned provider from signing an encounter include: 

• A note saved as a draft (Add Note). This is indicated by the word Draft in the note on the 
Encounter Summary screen. This is resolved when the author edits the note and then saves it as 
complete. 

 
Draft Note in the Encounter 

• Pregnancy Flag. If the patient is flagged as being pregnant, the LMP and Estimated DOB are 
required dates. This female data will persist from previous encounters.  Enter the required dates in 
the Screening or Disposition modules to sign the encounter.  

NOTE:   The Estimated DOB MUST not be  in  the past.  If  the patient does not deliver by  the 
Estimated DOB,  this  sate must be change  to  reflect  the new Estimated DOB  (Date of 
delivery). 

• Injury Flag. If the injury flag is checked, the date of the injury/accident, the cause code, and the 
location of the Accident (if an auto accident) are required. This can be documented in the 
Screening, Disposition or A/P modules. Additionally, an E code diagnosis is required to be 
documented in the A/P module. 
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Date and Related Cause Code Window 

• Unassociated Procedures. Each procedure must be associated to at least one diagnosis. This 
issue is indicated by the order or procedure in bold text in the A/P module or so noted on the 
encounter note. Use the associate/unassociate button in the A/P module to link the order or 
procedure to the diagnosis. 

 
Unassociated Procedure in A/P 

 
Unassociated Procedure on the Encounter Summary 

• Additional Providers: When a second clinical team member is added to the encounter using the 
Add. Provider functionality, each procedure must be associated to one or more of the clinical 
team members. If the additional team member is documented prior to the documentation of the 
procedure(s), the Procedure Details window is automatically displayed and the procedure can be 
associated to the correct team member. If this is not done or the additional team member is 
documented after the documentation of the procedure, the error message “No Provider” is 
displayed when leaving the A/P module and when signing, the error message will say the A/P 
section is incomplete. 

To correct this issue, associate each procedure to a clinical team member either through the Encounter 
Summary screen or A/P module. 

Encounter Summary Module:  

1. Click Add. Providers from the Action bar. 

2. Select the appropriate clinical team member next to the procedure. 
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Provider and Roles Window 

3. Click OK and continue to sign the encounter. 

A/P Module: 

1. Navigate to the A/P module. 

2. Select a procedure from the Diagnosis box. The Procedure Details window opens. 

3. Select the appropriate clinical team member next to the procedure. 

 
Procedure Details Window 

4. Click OK and continue to sign the encounter. 

• Draft Consult: When an encounter contains a draft consult, it cannot be signed. A message is 
displayed stating that the encounter has incomplete items in the A/P section. On the Order 
Consult tab, in the A/P module, draft consults are located at the bottom of the tab. This consult 
can be deleted or submitted in order to sign the encounter. 
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Draft Consult in the A/P Module 

2.7 Adding Comments to Walk-In Appointments and Telephone Consults 

2.7.1 Adding a Comment to a Walk-in Appointment 
Comments can be added to an appointment when the patient is walked into your clinic. After the 
appointment is created, comments are added by: 

1. Open the Appointments module. 

2. Select the appointment from the Appointments List. 

3. Click View Comments on the Action bar. The Appointment Comments (Read Only) window opens. 

 
Appointment Comments (Read Only) Window 

4. Click Edit to add a new comment or to edit an existing note. Notice that the window changes to (Edit 
Mode). 

5. Enter your note and click Done. 

2.7.2 Adding a Comment to a Telephone Consult 
Comments may be added to a telephone consult after it’s initially created. Perhaps the provider or nurse 
may want to document they attempted to call the patient, but did not receive an answer, or the nurse found 
needed lab results and wanted to get them in the encounter for the provider.  

To add a comment to a telephone consult: 

1. Open the Telephone Consults module. 

2. Select the telcon from the Telephone Consults list. 
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3. Click Notes on the Action bar. The Appointment Comment (Read Only) window opens. 

 
Appointment Comment (Read Only) Window 

4. Click Edit Note to add a new comment or to edit an existing note. Notice that the window changes to 
(Edit Mode). 

5. Enter your note and click Note Complete. 
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2.8 Quick Reference—Appointment Statuses 
AHLTA appointments change statuses as a patient progresses through a visit. The status can be found in 
the electronic SF600 or in the Appointments module. 

(blank) When no status appears, the appointment is pending. The patient has 
an appointment that was scheduled prior and has not checked-in. 

Checked In Appears when the patient has been checked in using AHLTA. 

Checked In on 
CHCS 

Appears when the patient has been checked in using CHCS. This 
appointment can be used in AHLTA just like an appointment checked 
in using AHLTA. 

Waiting Appears when vital signs have been documented. Generally, this status 
indicates that screening has been completed and the patient is ready to 
be seen by the provider. 

In Progress Appears when the S/O or A/P module has been opened. Generally, this 
status indicates that the provider is documenting the encounter. 

Complete Appears after the provider has signed the appointment. 

Updating Appears after the encounter was signed, but the encounter has been 
amended. It is necessary to sign the encounter now. 

Updated Appears after the provider has re-signed an amended appointment. 

Needs 
CoSignature 

Appears after the provider has assigned a co-signing provider who has 
not signed the appointment yet. 

Any appointment completed in AHLTA (Complete or Updated status) will automatically code in CHCS I 
ADM/ADS. If information is manually entered into ADM/ADS and the appointment is signed in AHLTA 
Comments can be added to an appointment at a later date, the code generated (or entered) in AHLTA will 
override any manual entries in ADM/ADS.  

It is imperative that if an appointment is completed in CHCS and manually coded in ADM/ADS, the 
appointment be left alone in AHLTA. If (in this case) an appointment is cancelled in AHLTA, it will 
overwrite the status in CHCS, even if the appointment is in a “Kept” status.  

The best workaround to view only the appropriate appointments for the current day is to set the 
appointments filter to Today Only. This is done through the Change Selections button on the 
Appointment List. 

2.9 Co-Signing Encounters 
For users that need to have their encounters co-signed, they may notice a delay in their ability to search 
for the provider that needs to co-sign their encounters. It can take upwards of two minutes to be able to 
search for the correct provider’s name. This can apply to some techs, CNAs, and residents. The delay is 
only encountered during the first search of each AHLTA session. 
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For those users that only have one person co-signing all their encounters for a given day, it’s much easier 
to pre-position the co-signer’s name through the Options of the encounter. 

For users that have a variety of people that need to co-sign their encounters, the most common person can 
be placed here; however, when this person is not the one that will be co-signing a particular encounter, 
this name must be changed when signing. 

It’s important to remember the delay in searching for the co-signer’s name only happens the first time 
during each log on. Users are encouraged to use CTRL-Z to lock their session instead of signing off of 
AHLTA during periods of inactivity throughout the day. 

Ensure your encounter closes prior to using CTRL-Z. By not signing off of AHLTA, the next time a 
search for a co-signer is needed, it will be considerably faster. 

2.10 Changing the Signature Block 
Signature blocks need to be updated to match the credentials of the provider. It is important to change 
your signature block the first time you see a patient.  

To change your signature block: 

1. Click Options in the upper, right corner of the electronic SF600. The Encounter Summary Properties 
window opens. Notice that Line 1 and Line 3 automatically populate with your name and MTF. 

 
Encounter Summary Properties Window 

2. Change the text in Line 2 to match your level of credentialing (i.e., RN, LPN, Physician, Family 
Practice Physician, Chief, Family Practice Clinic, etc). You can choose to use your standard DAC or 
military signature block for convenience. 

2.11 Routing Telephone Consults 
AHLTA will not allow you to transfer a telephone Consult (Telcon) to a nurse for action unless the nurse 
can sign the Telcon.  
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This can be easily over come by using the Call Back number for the Telcon to indicate “Action Codes.” 
Your clinic can designate a code for a provider and a separate code for a nurse. When the provider needs 
the nurse to take action on a Telcon, the provider will click on the Edit Phone # button on the action bar, 
and place the Nurse Action Code (@ for example) in the front of the Call back number. When the Nurse 
sees this code, the nurse will know that he/she needs to look at this Telcon and read the provider’s 
instructions. When this is done, the nurse will change the Action Code back to the Provider Code (# for 
example) so the provider will know the action has been performed. 

Prior to starting this process, the support staff will need to set the options in the Telephone Consult 
module Change Selections for ALL of the providers they support. Coordination on which codes will be 
used is also necessary. Adjustment of the columns in the Telephone Consult module will be necessary to 
move the call back number into view. Some suggestion for action codes are: 

• @ for the nurse action code 

• # for the provider action code 

If the provider wants a specific Nurse to take action, he/she can place the Nurse’s initials after the action 
code, for example, @CW(210)555-1212. 

If the patient calls a second time without provider action, the staff may want to put two action codes in 
front of the phone number. At a glance, this will let the provider know this patient has called again. 

An Example workflow would be: 

A clerk received a call from the patient and initiates a Telephone consult. The clerk confirms the Call 
back number and places the Provider action code in front of the number. 

When the provider checks the Telephone Consults module, he/she will see new Telcons with the provider 
action code in the call back number. The provider should not open the Telcon at this time. All the 
provider needs to do is single-click the tcon, and click the Notes button in the Action bar. After reading 
the notes, if the provider wants the nurse to perform some action, the provider would edit the notes box 
and enter the instructions to the nurse and change the action code to the nurse’s code. 

The nurse will see his/her action after he/she enter the Telcon module, or performs a Refresh of the 
Telcon module. The nurse can sort all of the Telcons for all of the providers they support by clicking on 
the Call Back Number column header. This will put all of their Telcons requiring action together in one 
place on the list. Again, without going into the Telcon with a double click, the nurse clicks on the Notes 
button and document what he/she did for the patient. After completion, the nurse changes the action code 
back to the provider code so the provider will know the action is complete. 

After the provider completes and signs the Telcon, all of the notes will be documented in the Telcon. 

A variation to this workflow would be to document all actions in a new Add note section of the encounter. 
This will allow for an automatic date and time stamp on the entry. 

When the Telcon is first created, no action code is used. This alerts everyone that NO ACTION has taken 
place on the Telcon yet (as apposed to this already having gone from the provider to the nurse, and back 
to the provider.) 

2.12 Consult Log Module 
The Consult Log Module will track the consults you have ordered, as well as the consults that are ordered 
to you. This module is a provider specific module, meaning it will not track consults by a particular 
patient. The consults ordered for a particular patient can be viewed at the bottom of the Order consult tab 
in the A/P module. 
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The Consult Log Module is located on the Folder List. When selecting this module, you will be presented 
with the consults you have written, as well as any consults written to you. 

Consults written to your clinic will not be displayed because a particular provider is not listed in the 
consult.  

To define the consults you want to see: 

1. Click the Change Selections button in the Consult Log module. The Consult Log Selections window 
opens. 

 
Consult Log Selections Window 

2. In the Consults For area, select the type of consults you want to see. 

3. In the Consult Status Selection area, select the consult status types you want to see. 

4. In the Appointment Dates area, set the date range of the appointments you want to see. 

5. In the Consult Order Dates area, set the date range of the consults you want to see. 

6. In the Optional Fields area, select the optional items, if any, you would like to include in the report. 

7. Click OK. 

The Consult Log module is a helpful tool that allows you to monitor your patient consult statuses, 
insuring that all consults are being appointed.  

The consult log will be helpful in discovering the statuses of the consults written for your patients to 
insure that the consults are being appointed. 

Once the consults are listed, you can click on the Patient column header to put your patients in 
alphabetical order. If the consult is completed, you can view the consult by double-clicking the consult or 
by selecting the patient and going to either the Previous Encounters module or the Clinical Notes module. 

2.13 Copy Forward 
The copy forward function allows you to bring the S/O section of a previous note forward into your 
current encounter for your patient. In addition, it will bring forward the diagnosis, procedures and orders 
(in the form of an order set) into the A/P module. 

This is particularly handy for follow-up visits or visits where the note from the last visit is a good starting 
place for the note in your current visit. 

Copy Forward can be performed from any previous encounter, you are not limited to only the previous 
encounters written by you. 
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To Copy Forward: 

1. With an encounter open, go straight to the Previously Encounters module.  

2. In Previous Encounters module, single click and review the previous encounter you will Copy 
Forward. 

3. Right-click the previous encounter and select COPY FORWARD (or button on the action bar). 

4. In the current encounter, you will find a new “template” called Copy Forward Template. If it does not 
automatically take effect, you will need to select it from the pull-down menu. 

5. Each line item that was selected from the previous encounter will be displayed in the Copy Forward 
template. The way the item was used in the previous encounter will be highlighted in yellow.  

6. Select the items you need. If you want all of the items in your note to be the same as the previous 
note, click the AutoEnter button. All of the yellow items (both positive and negative) will be entered 
into your note. 

When you are seeing this patient, the yellow indicators will give you a good indication of how the patient 
was during the last visit and can help determine how the patient has improved since the last visit. 

Copy Forward can also be used for part of the note. For example, you can have a technician or nurse use 
Copy Forward to bring forward just the past medical history section of your patients for easy review. 
After reviewing, put an item in your template saying PMH reviewed. 

2.14 Telephone Consult Surrogate 
There is no Telephone Consult Surrogate function in AHLTA. However, you can get around this by using 
your Change Selections options within the Telephone consults module to view an additional provider’s 
telephone consults. 

1. Click the Change Selection button from the Telephone Consults module. 

2. Select the provider(s) you are assisting from the Telephone Consult Search Selections window. 

3. Set the time range. If you select All Outstanding or Today Plus Incomplete, Telcons that have been 
addressed (although not in AHLTA) will display. You can use the date range to display only the 
current Pending Telcons. 

4. Click OK. 

2.15 Suggested Procedures After Documenting in the Wrong Patient Record 
When information is inadvertently entered into the wrong patient’s chart and the encounter is signed, the 
following steps are used to document the mistake. Please note, because this record was signed, all deleted 
information will go into the Change History Section of the record.  

The signing provider must go into the patient’s record that received the incorrect information to delete the 
invalid information from the chart: 

Go into the Previous Encounters module and select the encounter and click Amend on the Action Bar. 
This opens the encounter where all information can be deleted. Go into each section and delete or remove 
the invalid information from the various sections. 

AutoCite: Turn off all AutoCite properties to all areas to remove information from the encounter. 
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Screening: Remove any symptoms by highlighting and clicking the Remove button. Also remove any 
comments as necessary. For female only data, click the Reset button. 

Allergies: Remove as necessary. 

Vital signs: Enter the vital signs module and click the review tab. Highlight the entry (or entries) for this 
encounter and click Edit. Remove all information.  

S/O: Enter the S/O module and highlight the note(s) and click on the delete button.  

NOTE:   If  this  note will  be  recreated  for  the  correct  patient,  you  can  use  the  S/O  template 
creation feature to create a template form your S/O documentation before deleting. You 
will be able  to use  this  template  to  re‐due  this documentation on  the correct patient. 
You need to remember or make a note of which items were marked positive and which 
are negative. Your free text will carry into the template for use on the correct patient.  

A/P: Remove all the diagnoses by highlighting and clicking on Delete You may want to also create an 
encounter temple to capture the diagnosis (if the list will be extensive), but please note the comments on 
the diagnosis will NT save into your template.. Prior to deleting, you can copy them to MS Word to re-
copy them back into the correct patient if needed.. Highlight and remove any orders and or procedures. 
Cancel or Discontinue any orders from the lower section or cancel in CHCS. Enter the diagnosis of 
V65.9 Outpatient Physician Consultation.  

Disposition: Change the E&M code to 99499 Unlisted E&M service and remove any comments or 
checkboxes. 

In the Add Note section, make an entry stating that the entries below (in the Change History Section) are 
to be disregarded, these entries were made in the wrong record. This text can be enlarged and bolded to 
make it stand out.  

Re-sign the encounter and the status will change to Updated. 

Problems List: The previous diagnoses will be listed in the problems list. Edit the problems and select 
Deleted (error) for the status. 

Cancel the CHCS appointment. 

2.16 AIM Forms 
AIM (Alternative Input Method) forms are built by AMEDD and are intended to be used as a faster, 
simpler method of documenting the S/O portion of the note.  

The AIM form can be: 

• found already linked to a pre-built AMEDD encounter template or 

• linked to an encounter template by you 

• used to document an S/O note alone  

2.16.1 Pre-built AMEDD Encounter Templates with Embedded AIM Forms 
The new naming convention for AMEDD Encounter Templates with embedded AIM forms is as follows: 
RHEU--General--AIM--AMEDD where RHEU--General is the specialty followed by --AIM--AMEDD 
which identifies that it is an AIM form developed by AMEDD and linked to an encounter template. 

To find pre-built AMEDD Encounter templates with embedded AIM forms: 
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1. Open the Tools Folder. 

2. Click Template Management. 

3. Select Search from the Action bar. 

4. Type AMEDD in the Template Name Field. 

5. Click the drop-down arrow for the Owner Type Field. 

6. Click Enterprise. 

7. Click the Search button at the bottom of the Encounter Template Search Screen. 

To mark an AMEDD Encounter Template with an embedded AIM form as one of your favorites (this step 
makes the selected form(s) available in every encounter by selecting the S/O template selection drop-
down box): 

1. Right-click the AIM form you want to mark as your favorite. 

2. Click Add to Favorites. 

2.16.2 Locating an AIM Form in the S/O Module 
To locate an AIM form in the S/O module: 

1. Click the Template Mgt. button on the Action Bar. 

2. Type what you are searching for in the Name Contains field. For example, if you are searching for 
AIM forms related to pediatrics, type PEDS. 

3. Click the FindNow Button. 

4. Scroll to the bottom of the list, the icon for an AIM form has a blue bar at the top and looks like 2 
pages side by side. 

NOTE: AIM  form can not be searched  for by using  the Search button on  the Action bar. That 
search will only find traditional S/O templates. 

To mark the form as a favorite: 

1. Right-click the AIM form. 

2. Click Add to Favorites (if you selection does not move to the top of your list under your favorites, 
perform the steps again). 

2.17 Circuit Rider Transfer Process 
The AHLTA Enterprise account enables users to transfer from one AHLTA Medical Treatment Facility 
(MTF) to another AHLTA MTF. The updated steps list the procedures for handling the case when a user 
is a Circuit Riding Provider (i.e. a provider who performs short term rapid TDYs to 2 or more sites with 
different CHCS hosts, with return to home station). Therefore, a CHCS I account should already exist at 
the gaining MTF. 

This procedure applies to all personnel designated to support the AHLTA Circuit Riding Provider 
Transfer process. 

Steps to transfer access to gaining MTF for Circuit Riding Providers: 

1. Provider/administrator notifies the losing MTF of the TDY dates and location. 
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2. Losing MTF will: 

a. Telephone the gaining MTF (Tier 0) to notify them of the temporary transfer of the user, confirm 
Provider IEN, User IEN, and start/end dates of the TDY.  

b. Telephone the Military Health System (MHS) Help Desk Tier 1 to open a Manage Now (MN) 
ticket between 0001 and 1400 ET on the day before the provider will arrive with the following 
information: 

• AHLTA account name for the traveling provider 

• Domain for the gaining MTF (or site name) 

• Time when provider will be finished at losing MTF 

• Time when provider will begin work at gaining MTF 

• Provider Internal Entry Number (IEN) and User IEN from losing MTF 

• Provider IEN and User IEN from gaining MTF 

• Requests ‘ACCTRANCR’ identifier to be added to ticket 

• Requests date of account transfer to be placed in the abstract section of the MN ticket. 

c. Telephone the gaining MTF (Tier 0) to notify them of the MHS MN ticket number. 

3. Tier I will: 

a. Escalate the MN ticket to Tier II within one hour of receipt if all the necessary information is 
contained in the ticket. 

b. (For incomplete tickets) Telephone the losing MTF to get the missing information. This delay 
could result in the account transfer not happening on schedule, and the TDY provider could be 
unable to use his AHLTA account when he arrives at the TDY location. 

4. Tier II will: 

a. Verify that the losing and gaining sites’ information has been appropriately identified and posted 
to the MN ticket.  

b. Post the Account Transfer script to the ticket 

c. Transfer the MN ticket to Tier III (Integic) NLT 1600 to check for Duplicate Numeric Concept 
Identifiers (NCIDs). 

5. Tier III (Integic) will: 

a. Check for Duplicate NCID. 

NOTE:   Check for Duplicate NCID is usually not needed except for the first time a Circuit Rider 
goes TDY to a new location. If Duplicate NCID exists, a provider merge script must be 
run before the account transfer script can be run. 

b. Send the provider merge script to the Defense Information Systems Agency (DISA) (if 
necessary). 

c. Send the account transfer script to DISA. 

6. DISA will: 

a. Run provider merge script, if needed. 
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b. Run account transfer script for all tickets with the ‘ACCTRANCR’ identifier based on 
timeframes indicated in MN ticket. 

7. Provider will: 

a. Coordinate with gaining site system administrator to activate their account when they arrive on-
site. 

8. At the end of the TDY, the TDY site becomes the losing MTF, and will open a new Manage Now 
ticket, and the process will start over. 

9. If the TDY is cancelled short notice for unforeseeable reasons, the losing MTF will call the MHS 
Help Desk promptly. MHS Help Desk and DISA will make their best effort to halt or reverse the 
account transfer. 

Losing 
MTF 

Gaining 
MTF 

Tier I 

Tier II

Integic

DISA

Provider notifies 
MTF of the TDY 
dates and location 

Telephone MHS Help 
Desk to open a 
Manage Now (MN) 
ticket by 1400  ET the 
day before the 
Provider arrives

Telephones 
gaining MTF to 
notify them of 
the temporary 
transfer, the 
MHS MN ticket 
number, and 
confirms start  
and end dates

Escalate the ticket within 
1 hour of receipt  if all 
information is in the ticket 

•Verify losing and gaining 
sites’ information has 
been identified and 
posted to the MN ticket
•Post the Account Transfer 
script to ticket and transfer 
to Integic NLT 1600 ET

•Check for Duplicate NCID

•Send the provider merge 
script account transfer script 
to DISA 

Run provider merge and 
account transfer script for all 
tickets with the 
ACCTRANCR identifier 

Provider coordinates 
with site to activate 
account upon arrival

Information required in MN Ticket (from 
losing MTF):

• CHCS II account name for the traveling provider
• Domain for the gaining MTF (or site name)
• Time when provider will be finished at losing MTF
• Time when provider will begin work at gaining MTF
• Provider Internal Entry Number (IEN) and User IEN 
from losing MTF

• Provider IEN and User IEN from gaining MTF
• Requests ‘ACCTRANCR’ identifier to be added to
ticket

• Requests date of account transfer to be placed in the 
abstract section of the MN ticket

 
Transferring AHLTA Accounts to a New MTF for a Circuit Riding Provider 

Prepared by: AHLTA Deployment Operations Center (CITPO) 

2.17.1 Information Needed in Manage Now Ticket 
The following information is needed in the manage now ticket: 

1. AHLTA account name for the traveling provider. 

2. Domain for the gaining MTF (or site name). 

3. Time when provider will be finished at losing MTF. 

4. Time when provider will begin work at gaining MTF. 

5. Provider Internal Entry Number (IEN) and User IEN from losing MTF. 

6. Provider IEN and User IEN from gaining MTF. 

7. Requests ‘ACCTRANCR’ identifier to be added to ticket. 
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8. Requests date of account transfer to be placed in the abstract section of the MN. 

Problem Details 
Problem #: 11770484  Abstract: 701456 - ACCTRANCR - TDY – Spangler 1800 28OCT2005 

Problem Information Contact Information Problem Date Information 
Status: OPENWAIT  Full Name: LONG , RICKIE G Occurred Date/Time: 10/28/2005 12:08:23 
Request Type: PROBLEM  Employee ID: MHSRICKLONG  Open Date/Time: 10/28/2005 12:08:23 
Call Code: Call  Phone: 520-533-1345  Original Target Date/Time: 10/28/2005 

16:08:23 
Severity: 3 - Sev 3 Alternate Contact:  Current Target Date/Time: 11/02/2005 

12:08:23 
Original Severity: 2 - Sev 2 Department: RAYMOND W. BLIS Resolved Date/Time:  
System: MHS_CHCSII  Division: N/A  Close Date/Time:  
Component: SYSTEM  Service Level:  Duration:  
Item: ACCOUNT  Site: MHS_FTHUACHUCA  Call Back Date/Time:  
Module: CIRCUIT RIDER  Address: CLINIC_0008   
User ID/Name: RWANG / WANG, 
RAYMOND 

Floor: FT. HUACHUCA, AZ    

Group ID: MHS_CHCSII_T3  Room:  Bridging Information 
Resolver User ID/Name:  City: R W BLISS AHC-FT. 

HUACHUCA  
Not Bridged 

Resolver Group ID:  State: AZ  Bridge Ticket #:  
Reporter User ID/Name: 
JAMAYA/AMAYA, JOSE 

Zip: 85613    

Reporter Group ID: MHS_T1 Site Support: ARMY   
Cause Change Number:      
Cause Code:      
Customer ID: MHS      
Account ID: MHS      
Node ID:  Additional Contact Information Lock Status 
# Times Reassigned: 9 E-MAIL: 

RICK.LONG@AMEDD.ARMY.MIL
Locked By:  

Duplicate Problem #:  Fax Internal: Comm # 520-533-3951 User:  
  Secondary Phone Internal: DSN # 

821-1345 
Contact Methods:   

  Title: Site Manager \ SAIC   
      
      
      
      
Description 
Provider will be TDY/Finish at site.  Date/Time finished at losing site - 28 Oct 05 - 1800 Local  
Resolution 
Forward to CHCSII Tier 2, currently unresolved.  
 

Call Notes 
Taken By Call Date/Time Contact Note 

JAMAYA/AMAYA, 
JOSE  

10/28/2005  12:08:23 Full Name: LONG, RICKIE G  
 
Location: MHS_FTHUACHUCA  
 
Phone: 520-533-1345  

Provider will be TDY at site. 
Date/Time finished at losing site -  

  
Example of a Manage Now Ticket 

Prepared by: AHLTA Deployment Operations Center (CITPO) 

2.18 Batch Printing SF600s 
To print multiple SF600s for a patient: 

1. Select the patient via Search. 

2. Click Previous Encounters in the Folder List. 
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3. Click the View All radio button.  

4. Select the first encounter to be printed. 

5. Hold down the Shift Key and click on the last encounter to be printed. 

6. Click File on the Menu Bar. 

7. Click Print in the drop-down menu. 

8. Click SF600 in the menu tree. 

9. Within the Print Dialog Box, click OK for each encounter to print. (Print jobs will be sent to the 
printer.) 

2.19 Medications Initially Ordered at Another CHCS Host Site 
For medications initially ordered at another CHCS host, the fix in 837p11 will do the following:  

If a provider opens the "Medications" module and selects that medication, the "Renew" and "Modify" 
actions are disabled. The "Discontinue" button is not disabled, and can be used to discontinue the 
medication. 

If this is done, the med's status will change to “Discontinued in AHLTA.” AHLTA will treat it the same 
as a discontinued/inactive med, except that it will still trigger an alert for a drug-drug interaction if an 
incompatible drug is ordered at the new site. In part, this is due to the CHCS business rules noted below, 
but this also serves as a "safety net", in case the patient still has some left over--alerts provider to 
emphasize to patient not to take the discontinued med.  

Discontinued med will be excluded from the Current Meds views (when filtered to display only current 
meds), and will not appear in AutoCites. 

NOTE:  Due to attribution/traceability business rules built  into CHCS, discontinuing a med  in 
AHLTA will  not  discontinue  it  in  the  originating  CHCS  host,  as  the  discontinuing 
provider  generally  wonʹt  have  an  account  in  the  originating  CHCS.  Renewing  or 
modifying the med at the originating site (generally would only happen if the patient 
returned to  it) would over‐write the  ʺDiscontinued  in AHLTAʺ status and update the 
status to whatever the provider at the originating host now set it to. 

2.20 Adding an order to an order set. 
So you have your order set all built and read to go. Great, they will save you lots of time. Now it’s the 
first time you use it you discover you left out and order. Rats, you have to go through the whole thing 
again and add it. Well, no you don’t, it’s very simple to add an order “on the fly” as you document on 
your patients. All it takes is a little detour to the Order Set tab before submitting.  

Lets say you left out the CBC. Follow the steps below to add the CBC. 
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Order Sets Tab 

1. Just go over to the Order Lab tab and find the specific test you need. 

 
Order Lab Tab 

2. But instead of submitting it, use the Save to Queue button right next to it. This will put that order 
over to the Order Set tab where it can be saved. 
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Order Sets Tab 

NOTE:   The order is checked. (Only the orders checked will save). 

3. Click the Save as Order Set button. 

4. Select the encounter template you want to add the order to.  

IMPORTANT!!! 

Select the Add To button to add just that order into the encounter template. 

If you select Replace, you will erase everything in the template and replace it with the single order. 
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Saving an Order into an Encounter Template 

5. Now, to take care of your patient, click the Submit button on the Order Set tab to send the order. So a 
simple little detour to the Order set tab will place that order in the order set for next time. 

6. You can save this additional order into other Order Sets or Encounter templates before submitting. 

2.21 Backing up templates 
Consider this. What would happen if you came to work one morning and all the templates you use on a 
daily basis were GONE? Do you have a plan in place so you can continue working? The IMD folks plan 
for the possibility that data can get lost or corrupted. It’s called a Disaster Recovery Plan and generally 
it’s thought of in terms of a large scale data loss. However, the IMD gurus do not have access to back up 
your AHLTA templates. Therefore it would be prudent to create your own plan for Backup and 
Recovery of your templates in the event of a catastrophe. 

Here are the Steps: 

1. To backup S/O templates, you must have an open encounter. 

2. After opening the encounter, navigate to the S/O module and click Template Mgt on the Action bar. 

 
Template Mgt Button on the S/O Action Bar 
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3. Expand My Favorites by clicking on the little plus and click once on the first template to highlight it. 
Scroll down to the last template. Hold down the <Shift> key and click on the last template in your 
favorites. This will highlight all the templates.  

 
Highlighted Templates 

NOTE:   Only S/O templates can be exported in “bulk” like this. AIM Forms must be exported 
individually. 

4. Click the Export icon on the Action Bar.  

 
Export Button on the Template Management Action Bar 

5. Browse to wherever you want to store your templates. It can be a drive and folder on the network, a 
separate folder on your workstation, a thumb drive or even a floppy diskette. Click OK. Your 
templates have now been backed up to another location! 

 
Select Export Path Window 
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6. Complete the process by selecting individual AIM Forms, click Export, browse to the backup 
location (Notice this looks a little different than with the S/O templates, but the result is the same.) 
Click Save. 

 
Export S/O From Template Window 

Now you can copy the templates and aim forms to another location for safekeeping. You can zip them up 
and email them to a personal email account, burn them to a CD or copy to floppy or thumb drive. 

Exporting the Encounter template works much the same way. Within the Template management module, 
click on the Search Browse Tab. Bring up the templates you wish to export.  Highlight the specific 
templates you wish to export and click on the export button on the action bar. 

2.22 Restoring Templates from Back-up 
Backing up your templates is only half a disaster recovery plan. After they are stored away for 
safekeeping, how are they restored if disaster strikes? Essentially it is the backup process but in reverse. 

Follow the steps below to restore your templates. 

1. Click on the Import icon on the Action Bar. AHLTA calls this procedure importing templates and 
not restoring them. As in exporting, to import, you must have an open encounter and be in S/O 
Template Management.  
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Action Bar 

 
Import Medcin Template Window 

2. Browse to where the templates are stored. Click the dropdown next to the box that says Template 
Files and select All Files.   

 
Import Medcin Template Window 

3. Click the double right chevron (>>) to move all templates from the Available Templates pane to the 
Selected Templates pane.  

4. Uncheck the Shared checkbox.  

5. Click Import. This will import all the S/O templates into your favorites.  

NOTE:   AIM form templates have the file extension of .TXT and Traditional S/O templates have 
a file extension of .ltp.   

2.23 A quick review of vital signs 
The often overlooked Vital Sign Review module will display the current and historical vital signs. This 
module is very helpful with documenting within an encounter too.  To view the vital signs taken during 
the current encounter, most users will close the S/O module to view the vital signs within the encounter 
screen. This is unnecessary. Simply bring up the Vital Signs Review module from within the S/O module 
(or the A/P and Disposition modules). 
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Within the S/O module, or any other module, click Vital Signs Review to see the vital signs taken earlier 
during the visit. 

  
S/O Module 

Because all the historical vital signs are also displayed, you the advantage of being able to compare the 
current set with the vital signs from previous encounters.  

 
Vital Signs Review Module 

When finished, close the Vital Signs Review module to pick up where you left off.  
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2.24 Changing My Password 
You can change your AHLTA password any time you like, however it must be changed every 85 days. 
Even if you use your CAC to log in, you must change your password. You should receive a notice to 
change on or about the 80th day following your most recent password change. 

AHLTA passwords must be 8-20 characters long and contain Upper Case characters, Lower Case 
characters, 2 Numeric characters and a Special character (more about this in a moment).  

To change your Password: 

1. Log in to AHLTA as you normally would.  

2. Click File on the Menu bar and then click Change Password. 

 
File->Change Password 

3. A screen will open where you must enter your old password and then enter the new one twice. If you 
log in using your CAC and have forgotten your password you will need to have it reset by IMD 
before you can change. 

 
Change User ID and/or Password Window 
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4. Disregard the last line of the instructions. Beginning with Build (version) 838 the only Special 
Character allowed is the ! - exclamation point. Also the new password may not contain two 
exclamation points together i.e. Pa55word!! 

5. Click OK to save your changes. Remember, your password change in AHLTA will change the 
Access code in CHCS I. 

2.25 Place a Vital Sign Graph in our note. 
Graphing Vital Signs can provide a graphical representation of the patient’s blood pressure, pulse etc. 
Users have found it helpful to graph the patient’s weight along with their BP to graphically show the 
correlation between the two to their patient. 

The vital signs can be graphed from an open encounter note, but can also be done outside of an encounter 
and appended to a note.  

Here are the steps: 

1. Open the patient’s medical record.  

2. Click Vital Signs Review in the Folders List. This will display all of the patient’s vitals.   

3. Highlight the column(s) you wish to graph by clicking, and holding the mouse button down, drag to 
include all the data you want in the graph. The columns are like the ones in the appointment module - 
you can drag them to place them in the order you want for your graph. 

 
Vital Signs Review Module 

4.  Click the Graph Vitals button on the Action bar to display the graph. 

5. Select the style of graph that will best suit your needs. 



 

AHLTA How to Instructions and  35 
Quick Tips  6 October 2006 

 
Graph of Vital Signs 

6. Hold down the <ALT> key and press the <Print Scrn> button on your keyboard. This will copy the 
Graph Vitals window to your computers memory. 

7. Open the Excel Master Graphics file click on the screen shot tab. (There’s a button on the main 
screen to get you there.)  

 
Excel Sheet 

8. Right click in the big box to paste the image into the spreadsheet. This large box is pre-sized to fit the 
Add Note section in AHLTA. 
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9. The final image must be resized to fit in the large box to prevent it from being cut off within AHLTA. 
You can use the drawing tool to crop and resize the image. 

 
Excel Sheet 

10. The cropping tool is found on the picture tool bar. To display, Click on View -> Toolbar, select 
Picture.  

 
Crop Button 

11. When the image has been cropped and sized to fit inside the sizing box, click on the button labeled 
“Click here to copy form when finished”. This will copy your graph to the clipboard memory and 
minimizes Excel.  
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Excel Sheet 

12. In AHLTA open the Add Note section either by appending a previous encounter or by clicking Add 
Note in the SF600 or the Action Bar in an open encounter.  

13. Left click in the large bottom window, then right click and select paste. This will paste the graph into 
the note.  

 
Encounter Note Window 

14. Finally click Note Complete to save. The vital sign graph is now part of the encounter.  
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2.26 Selecting the 99499 E&M code 
A few clinics must always change the E&M code to 99499 because of coding guidelines. In future 
versions of AHLTA, users will be able set this as their default. Until then, there are a few easy ways 
change this setting. 

The E&M code is set in the Disposition module. The normal default settings bring up a calculated E&M 
code for and Existing Outpatient visit. 

 
Disposition Module 

A change of the Service Type to Other Unlisted E&M will change the E&M code to a 99499. 

The easiest way to do this is to click in the Service Type window and use your mouse wheel and roll your 
mouse wheel up twice. 

 
Disposition Module 

NOTE:   The Service Type field will still be active even if your mouse pointer isn’t in that field. If 
you move  your mouse  pointer  else where  on  the  screen, movement with  the  roller 
wheel still effects the Service Type field. Make sure you don’t inadvertently change the 
setting in this field before closing this module. 

You can also click on the down arrow for the Service Type box and move up two options.  

If this encounter will also be a “No count” encounter, selecting that option will also change the E&M 
code to a 99499. This method should only be used if the encounter will be a no count. 

2.27 Sorting the Medication List 
Often patients have quite extensive medication list. It may help find medication if the list was in 
alphabetical order. AHLTA can do easy!! 
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Just like in the appointment module, if you click on column header, it will sort the columns.  

So if your meds list looks like the image below, 

 
Meds Module 

A simple click on the Medication Name column header will resorts the meds, see the image below. 

 
Meds Module 

Meds easy to find, repeat meds together allowing you to view all of them together. 
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Try sorting on the Status column, which will put all of your patient’s active meds together. 

All with a simple click on a column header! 

Most other columns in AHLTA will do the same thing. Give it a try! 

2.28 Renewing a Prescription 
To renew a script for a med: 

1. Open the A/P module, select the Order Med tab and click Show Orders.  

 
A/P Module—Order Med Tab 

 
Show Orders 

2. Click the med to be renewed, then click Renew and Modify.  

 
Enter Reason For Action Window 

3. Put in the reason for the modification in the text box.  
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4. Click OK. Make sure the dispensing location show is the patient’s default pharmacy (usually at your 
facility).  

5. If Renew is clicked, the order will go to the original filling pharmacy. 

2.29 Ordering a Future Dated Lab or Rad Order 
Lab tests and radiology exams can be ordered to be done in the future. This will keep the order active but 
unable to be performed until the date and time you specify.  

Within the Order Lab tab, click the More Details button. This will open up the bottom of the screen 
where you can advance the date. The lab will not be able to accession the lab test (arrive in the lab) until 
that date and time.  

When ordering labs or rads to be done in the future, be sure to reset the timing field. It defaults to NOW. 
When the patient shows up for the lab test, the lab will not perform the test until the time specified. A real 
problem if the order was created at 4:00 PM and the patient comes to the lab in the morning. 

 
A/P Module—Order Lab Tab 

Set the Timing to AM to ensure that the order can be processed by the lab on the day you specify. 

 
Timing 

2.30 Styles of documentation 
The flexibility of AHLTA allows for a variety of styles if documenting the S/O note. The use of these 
styles will depend on the type of patients you are seeing and desired availability of a wide variety of 
templates as well as individual computer expertise. 

There is no right way or style of documenting within AHLTA. Often this would depend on the users 
individual writing style, how savvy the user is with computers, the users typing skills and desire to type 
free text vs. the desire to scan a longer list of options and many other factors. These factors will usually 
translate into the types of templates the users has in their favorites lists and quickly available for use. No 
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matter what style is used, getting the documentation done as quickly and efficiently while capturing all 
pertinent medical data is the prime goal. The solution will be different for each user. 

Documenting positive and negative symptoms separately. Some providers find it easier to keep the 
positive symptoms separate from the negative symptoms make it easier to focus in on the positive 
findings. This is done by pre-positioning all symptoms in the ROS section and using the ROS\HPI button 
to move only those positive symptoms to the HPI area. This method can be used with either disease 
specific templates or the default or overarching type of templates. 

Condition or disease specific templates. These templates are built around documenting a specific 
disease, complaint or reason for visit. Symptoms and physical findings included in the template are 
focused just what the provider will be documenting when a patient comes in for this reason. Often 
providers will have many templates of this nature for the common diseases or conditions they see in their 
clinic. When using this style of template, there is minimal searching for terms and entering free text 
typing and providers may elect to use the Autoneg feature of AHLTA to document negative findings and 
symptoms quickly. These templates must be tailored to the way the provider practices to be able to 
quickly document common items quickly. 

Overarching or Comprehensive template.  There isn’t single word to label this kind of template but 
some have called them “First Load” or “Default” templates. These types of templates are built to handle a 
wider range of diseases or complaints and can be loaded automatically when the user enters the S/O or 
A/P modules. The purpose of this template is to speed documentation when you do not have a disease 
specific S/O template or encounter template. The terms contained in this template will cover 
documentation on many conditions and contain common terms such as general appearance, normal lung 
sounds, normal abdomen statements, and other common symptoms and common physical findings. When 
this style if template is used, the autoneg feature is not used. 

As with all encounter templates, there are two main parts that are linked together, but are really separate. 
These two parts are the S/O template and the encounter template which will pre-position shorts lists of 
diagnosis, orders, procedures, and other therapies. 

Overarching or Comprehensive S/O template.  This S/O template will contain the common terms 
providers document on a wide variety of patients within Medcin.  

Pre-positioned in the HPI section are the Chief Complaint, Visit For and HPI free text box. The patient’s 
history is entered in free text, purposefully omitting specific symptoms that are best documented by using 
Medcin terms.  

The PMH tab contains all the common social and history items. Also include some history free text 
boxes to document pertinent historical information easily. Pre-positioned free text can cover your 
medication and Master Problem List reconciliation is preformed statements. 

The ROS tab contains symptoms your patients commonly complain of. Any symptoms your patient 
complained of can be selected positive and, with the use of the ROS/HPI “flip” button, this item is move 
into the HPI section. Use the duration and modifier buttons, as necessary, to document length of time and 
severity of the symptom(s). Use free text to capture any other pertinent information. Include a free text 
area to document symptoms not included in your template, don’t spend a lot of time searching for terms. 

The PE tab contains the alert and oriented information as well as commonly examined areas. Include the 
statements that will document your normal statements for each major area, (Lungs clear to auscultation, 
Heart Rate and Rhythm Normal, No murmurs Heard, Abdomen, Soft, Non tender etc) as well as other 
common areas (Ears, nose, neck, thyroid etc). 

The Test tab contains those common tests performed in your clinic such as EKGs, Occult Blood, Finger 
Sticks, etc. and provides an area to document those results. If you perform “wet reads” of x-rays, you can 
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include a place for your readings.  There is no need to include a place to document results of test 
performed in the lab because those can be brought over from the Lab module. 

Overarching or Comprehensive Encounter Template.  Each area in this template should contain those 
items (diagnosis, procedures, orders) you use most often. When this template is brought up in the S/O 
module, set as your default, each of the lists will display 

Diagnosis Tab. Include your most common AND those hard to find diagnoses. If this lists get to be long, 
you can put the most common diagnoses in the favorites list to separate the two.  

Order Set tab. Listed in the order sets tab are all the lab test your order routinely. Also listed are the 
common x-rays and medication ordered. Your practice will, of course determine what orders are this 
order set. Perhaps common antibiotics and pain meds could be listed here too.  

Procedures tab. This tab should contain the procedures done in your clinic. Since is may a shorter list, 
you may want to list them all. 

Other Therapies. You can list many items that cover a wide variety of diagnoses as well as the PPIP (Put 
Prevention into Practice) items. This will make the documentation this information take less time. Your 
“Return to clinic if worse or new symptoms” and “Watch for Sign and symptoms of infection” statements 
can be pre-positioned here to have them available quickly. 

The Overarching S/O and encounter template work best if they are linked so when load the encounter 
template, it will take effect in all applicable areas of your encounters. 

Using a Overarching template. As you start your documentation, many users go to the A/P module first. 
By going to the A/P section first, you can get the orders submitted and document some information to 
remind you about the patient if you need to move on to your next patient and complete the documentation 
later. 

With the overarching template set as your default, the diagnoses will automatically display.  If you know 
the diagnosis(es) at this time, go ahead and select it/them. Search for any diagnoses not on your template. 
Don’t forget about the problem list button. This will bring up all the active problems for the patient, 
which can be selected for easy documentation. If you are done with the patient, you can click on the 
comments/plan to document the plan on your patient. 

Go to the order set tab to submit any necessary common orders. Don’t for get to highlight the correct 
diagnosis so the orders are associated with the correct one. This will save time later. Of course orders can 
be submitted without a diagnosis if its not know yet. 

When you go into the S/O module, your Overarching or default template will automatically display. 
Document all necessary terms in this template by going to each tab. Try to develop a method that will 
bring you to each tab only once (the first time through). Use free text only when necessary. 

When you go to the ROS tab, click on the symptom the patient complained about and use the ROS/HPI 
“flip” button to move that term into the HPI section. Move up any other necessary terms. This will 
enhance your coding up to max of 4 items. (The Duration button and Modifier pull down box will also 
count for coding purposes.) 

The Diagnosis Prompt Button. Now, you have got the general stuff documented on your patient, what 
about the disease specific items? The Dx Prompt will filter Medcin and display the terms associated with 
a specific diagnosis. At first, you will be presented with a short list of the most common terms, by click 
on the List Size button, the list size will expand two times.  

Any items in common with your default template will display, already selected so you know you don’t 
have to select them again. 

Now all you need to do is go to disposition and sign your note.  
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2.31 Completing the Army Long Form Profile 
 

Completing and keeping track of the Long Form Profile (DA 3349) for active duty personnel can now be 
accomplished using AHLTA instead of paper. To utilize this feature, providers must have a special Role 
added to their provider profile. If the Army Readiness Icon isn’t visible in the Folders List, contact your 
AHLTA / CHCS Administrator and request the ”OMG_Test” role 

 
Folder List 

Clicking on Profiles under Army Readiness in the Folders List opens the Army Profile module. Any 
profiles entered for this patient can be viewed and managed here. This is also where any new profiles are 
created 

 
Army Readiness Module 

To create a new profile, click on the New Profile icon on the Action Bar. 

The new profile can be created from either an existing Enterprise template created by AMEDD or a user 
template you, as provider, created. A new profile can also be “created from scratch” as a Blank Physical 
Profile. 
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Create a New Physical Profile Window 

The Enterprise template and user Template profiles already have information filled in, however this can 
be changed to suit the individual details of this patient. 

 
Army Profile 
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Profile Type 

The temporary profile defaults to 1 month and has a maximum duration of 3 months.  

NOTE:  While the form says the max duration is 3 months, it is actually 90 calendar days. Keep 
this in mind since most three month periods contain 92 calendar days. 

Click on the Profiling Officer button and type in Name, Grade and select the Date. Click OK. 

To complete the profile, click Save or Save as Template. Saving as a template retains all the information 
in the profile including the profiling officer’s name, etc. 

 
Signature Window 

Clicking Save as Template will prompt for additional information. 
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New Physical Profile Template 

Select As a User Template and give it a relevant Name. Click OK. 

A new profile can now be created from this User Template. 

 
Create a New Physical Profile Window 

To print the profile, highlight it and click the Print icon on the Action Bar. It will print to the default 
printer for that workstation. 

 
Army Profile Module 

If the approving officer and unit commander have AHLTA access, the profile can be completed and saved 
in AHLTA. 

2.32 Problems Module 
The Problems Module can provide, in a nutshell, what has been done in CHCS II for a particular 
diagnosis. This module will list all the encounters for a particular diagnosis, all the medication, lab orders, 
radiology orders that have been associated with the diagnosis.  
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Problems Module 

As you document on your notes and perform the assoication between the diagnosis and the orders, this 
informaiton automatically populates here in the Problems Module. 

2.32.1 Course of Treatment 
This module also gives you an indication how many times this person has come in for a diagnosis, what 
was the course of treatment for the diagnosis and what exams, procedures and tests have been performed 
for the diagnosis. 
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Problems Module 

You can gain additional information on each item by double clicking on it move to that module. Double 
clicking on the encounter will bring you to the Previous Encounters module where this encounter can be 
viewed. Doubling clcking on a med, lab or rad test will bring you to the encounter where it was orderd 
(See Note below). 
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Problems Module 

Any items documented in the S/O module under family history are automatically entered in the family 
history section of the Problems Module. 

NOTE:   When routing to the Previous Encounters module you will only be presented with the 
last four encounters. If the encounter you clicked on in the problems module is not one 
of  the  last  four  encounters,  the  encounter  presented, will  not  be  the  encounter  you 
clicked on. To view additional  encounters,  check  the view all option  in  the Previous 
Encounters module.  

2.32.2 Maintaining the Master Problem List 
The Problems Module in AHLTA will contain a list of diagnoses for the patient. These diagnoses 
documented in encounters will automatically go to the Problems Module and will remain on that list until 
inactivated. 

This Master Problem List (MPL) must be maintained by inactivating diagnoses which are no longer 
considered a problem. Once a diagnosis is flagged as inactive, it will no longer show in the AutoCite 
section of the encounter. 

You have no doubt seen diagnoses such as Visit for: issue for repeat prescription or Sprained Ankle, or 
Patient Counseling etc showing up in your encounters as problems. These “Problems” are in the problems 
module because they we automatically brought over from an encounter. Each of these diagnoses should 
be inactivated so they are not documented in your encounters as an active problem. 

You may also see similar diagnoses on the problems list. Perhaps the patient was first diagnosis with 
“Systemic Hypertension” and later on a more specific diagnosis of “Essential hypertension, benign” was 
determined. The more general diagnosis should be inactivated so only the more specific single diagnosis 
is on the Problems Module. 
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Maintaining this electronic problems list is similar to the paper version of the problem list. That’s why 
they were written in pencil, so the problems can be erased when they are no longer and active issue. 

 
Problems Module 

Inactivating an old diagnosis is a simple process. Within the Problems Module, single click on the 
diagnosis. In the lower part of the screen, there is a status box. Change the status to Inactive and click on 
Save. That diagnosis is now inactivated and will not be AutoCited in your encounter.  

If your encounter was already open, when you return to the encounter, you will need to click on the 
AutoCite button to perform an AutoCite refresh, which will remove the diagnosis from the problems area 
of your encounter.  

2.33  Patient Check out 
In the Appointment Module of AHLTA, there is a check-out feature which will allow the users to 
document, or check the patient out of their clinic. This is an optional feature of AHLTA that will allow 
the user to print out various products from AHLTA. 

This feature is found on the Action Bar of the Appointments module.  

 
Check-Out 
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Check Out Window 

When selected, a dialog box appears allowing the user just to check out the patient, or select available 
printouts before checking out. 

The date and time can be adjusted to the correct time. The DD form 2766 as well as the SF 600 
(encounter form) can be printed out.  

The Check out function can be performed prior to the provider completing the encounter documentation. 
Only appointments with the status of InProgress, Completed and Updated status can be Checked Out. 

NOTE:   A patient can be checked out prior to the encounter being completed by the provider. 
The DD 2766 and the SF 600 will only have current information. 

The Print Orders option will print instructions and orders for the patient to have as a record. This Patient 
Check out Form will contain Medication orders, X-ray or Radiology Orders, Lab orders, Consult orders 
and a list of the needed Wellness Reminders for the patient. This sheet can contain instructions for each 
category orders such as operating hours for the Lab and X-ray and the facility process for consults.  

This Print out can be customized at the clinic level by updating the Check-Out data. The Clinic location 
set on the PC is the location that will be update when selecting the Update check out data. 

 
Tools Menu 

This information is filled out by each clinic and will be included on the Patient Check out Form. 
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Check-out form Information Window 

Examples of information that can be useful on this form would be the hours of operation and locations of 
each of the different department. Clinic specific information can also be included in this area.  

When a patient is checked out, the clinic data for the appointed clinic will display on the Patient 
instructions sheet.  Clinics with multiple sub clinics will need to enter data for each sub clinics that have 
appointments. To set up this checkout information, you will need to change the location of your PC to 
each sub clinic. Use Option File ->Change location. Entering this information in a Word document first 
then Copy / Pasting into CHCS II will greatly speed this process.  

Example Patient Check out Form.   
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Sample Patient Checkout Form 

NOTE:   Currently there are no reports that will pull this information to determine the length of 
time  between  patient  check  in  and  patient  check  out.  These may  be  coming  in  the 
future. 

2.34 Scanning documents into AHLTA using Microsoft Word. 
Scanning procedures are as varied as the software available we have available to use. These procedures 
use MS Word to size your full size sheets and will allow pasting of all pages at one time into an AHLTA 
Add Note or Clinical Note. 

These procedures were designed and optimized for the HP 5590 scanner where the HP scanning software 
was not installed. This process uses existing Windows XP software and programs and emphasis was 
made to deal with multiple page reports.  

The scanning is done using the Scanner and Camera wizard. The image files are then brought into MS 
Word, in mass, where they are automatically resized. These image files are then pasted (again, in mass) 
into the AHLTA encounter or Clinical Note.  

Once the scanner has been successfully installed an Icon will appear in the Scanners and Camera Icon in 
Control Panel. Click on Start and then control panel. Click on printers and other hardware (if in Category 
view). Locate the Scanners and Cameras Icon in Control Panel and double click the Icon for the scanner. 
Once the scanner Icon is clicked the following scan wizard will start. Click “Next” to proceed to the next 
step. (A short cut to the Scanners and Camera folder can be placed on your desktop for easy access.) 
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Scanner and Camera Wizard 

After you click “Next” you will be presented with another step in the wizard. If pages were already fed 
into the sheet feeder the “Paper Source” will populate with a source of Document Feeder, if not, now is 
the time to insert your pages in the document feeder, then select document feeder from the Paper Source 
pull down box.  

 
Scanner and Camera Wizard 

Page size should be changed to Letter 8.5 x 11. Under picture type select Custom and then Custom 
Settings. Under Custom setting, change resolution from 200 to 150 dpi. If possible, ensure that Black and 
White is selected. Click OK and then “Next” to proceed. Changing both the resolution and settings to 
black and white will greatly reduce the file size and allow for faster saving. Change these settings only if 
it still allows for a readable image. 

The next step in the wizard allows you to pick a destination for the scanned images. The default location 
for the scanned documents is under each individual user’s profile - My Documents\My Pictures. If name 
is entered into field 1 - “Type a name for the group of pictures”; A new directory will be created under 
My Pictures reflecting the name of what was populated in this field. We suggest using the Patients last 
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name. After these images are entered into the AHLTA encounter, these files can be deleted by deleting 
the folder. 

 In Field 2. “Select a file format” select PNG as a format. This will allow for a reduced file size.  Field 3 
represents the destination of the scanned images and does not need to change unless the images are to be 
stored in a different location. Click “Next” to proceed. 

 
Scanner and Camera Wizard 

After clicking “Next”, the following scanner window will open and the scanner will begin to scan the 
images to separate files. The files will be named with the name provided and 001, 002 etc. 

Once the scanner has completed scanning all the documents in the feeder, the next window will open. 
“Nothing I’m finished working with these pictures”, will be the default setting. Select “Next”.  

 
Scanner and Camera Wizard 

On the next window, select Finish. 
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With the image files saved, open MS Word with a blank document. In testing, the margins did not require 
adjusting from the defaults settings of Left and right at 1.25 and top and bottom at 1 inch. If you find this 
isn’t working, you may save a blank file with different margins and use that as a template each time. 

Click on Insert -> Picture -> from File. (See information at the end of this document for instructions for 
placing a button on your tool bar for easy access to this option.) 

Navigate to the folder where your image files are stored. 

Select ALL images belonging to this patient. Click on Insert.   

You may find it easier to view the document at 25% size so you can see all pages. 

 
25% View 

These images should fit one per page. Next you will insert a line after each image. This will allow all 
images to paste to the right of the Add note box. If this is not done, your images will attempt to go left to 
right and of course, cut off the right image in the Add Note box. Click just outside the lower right corner 
of the image and hit the enter key. The cursor should move to the lower left corner of the image. Perform 
this step for all images.  

Select ALL images by using CTRL A or Edit -> Select all. (See information at the end of this document 
for how to place a button on your toolbar to easily perform this function). You should see all of your 
images highlighted in black.  
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All Images Selected 

Once all images are selected, Copy them to your clipboard using CTRL C or Edit -> Copy. 

Switch to your AHLTA encounter and open up an Add Note box. Select New Note  Click in the large 
white work space (with the left mouse button) then right click in the same large white work space and 
select paste.   

 
Encounter Note Window 
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The Note Category and Note Title are optional. 

Click on Note Complete to save your note. 

After all images have gone in click on note complete to save your note. 

Scroll down through the encounter to insure all pages went in correctly and none are attempting to start on 
the right. If there are images starting to the right of another image, click on Add Note, then Edit Note to 
bring it back up. Ensure there is a blank line between each image. (It won’t hurt anything to have two 
blank lines if you are unsure one is in there or not.) 

You won’t need to save your word document, but don’t forget to delete your scanned images from you’re 
my pictures directory. Also don’t forget to empty your waste basket on your PC when you have 
completed the process. 

Adding a commonly used function to your tool bars. Microsoft has the capability to modify your 
toolbars at the top of the screen. For this process, you may find it handy to add the Select All and Insert 
Picture buttons for easy access. This option is located under Tools->Customize. 

 
Tools Menu 

This will bring up the Customize option box. On the center Customize tab, you will find most of the menu 
items on the menu bar.  

Click on the Edit menu on the left, and scroll down to find the Select All option. Click and drag the item 
to your tool bar. The Insert Picture from file option is found under the Insert menu on the left. 
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Customize Window 

With the loading of additional printer drivers, you may be able to scan multiple documents straight into 
Word. This eliminates the need to save your documents on your hard drive and delete them later.  

2.35 Decreasing Desktop Clutter 
AHLTA can have two distinct looks. These two different looks are user definable. 

The first is when the user uses the folder list for navigation. This is the most common but some users feel 
the screen is too crowded. 

  
Appointments Module 

The second look uses the Physician Short Cut bar. This short cut bar is available to all users regardless of 
their user role. 
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Appointments Module 

The user can customize the buttons that are visible. This may be a better solution if the user only needs to 
use a few modules. 

Changing these views is done in the view menu --located on the top menu bar.  

 
View Menu 

To remove the folder list, click on the Folders options and the check will remove and to folder list will 
disappear. 

To add the Shorts cuts, go back into the View menu and click on Shortcuts. In the fly out menu, select 
large Icons (for now). 
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Shortcuts 

The Physicians short cut bar is also called the toolbar. To modify the icons or buttons on the Physicians 
Shortcut menu, go into the view menu and select Toolbar and then select the Customize menu. 

 
Customize 
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You then display the Customize tool bar dialog box. 

Items displayed on the right are items that will display on the Physicians Short cut bar and on the Tool bar 
(upper left under the menu) 

To move modules over to the right, click the module then click on “ADD” (or drag the module over). 

 
Customize Toolbar 

The order they appear in the right window will be the order they appear in the Physicians Shortcut bar. 
Modules can be dragged up and down to adjust the order they will appear on your screen. 

If you place any patient specific modules in your shortcut bar (Lab, Radiology etc), they will only appear 
when you have a patient selected. Click OK when you are done. 

The Physicians Short cur bar works well for uses that only need access to a small amount of modules and 
can de-clutter their screens.  

Users can use the “Go” menu for access into less commonly used modules. 

2.36 Adding the “Other” Allergy in your pick list 
In the allergy module, it’s quick and easy to add common allergies to the pull down box. The Allergy 
Module allows entries for medication and some environmental substances such as wasp venom, eggs etc. 
Some common substances not included in the file are Latex, dogs, cats dander, cashew nuts etc.. This can 
be documented as an “Other” allergy with allergic item in the comments section.  
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Allergies Module 

By default, the Other allergy is not available in the pull down box and must be searched for using the 
Allergen button. By placing the entry of “Other” in the pull down box, it will speed documentation when 
that item isn’t available in the list, such as Dogs, Cat dander, Cashew nuts, or other comment. 

To edit the Allergen comments box, click on the Options button. Then in the properties box, click on the 
Add button.  

This will bring up the Search box where you enter “Other” in the search criteria. Select “Other {class}” 
and click on Add to common list. Then click on close. Click on Save then OK. Your new allergy is now 
in your drop down list, ready for quick documentation.  

 
Add Common List Items 

NOTE:   This entry should only be used for items not in the master allergy list. If a Drug allergy 
is entered in this way, it could adversely affect the patient care because if will not react 
to any medication the patient is receiving to provide any drug – allergy warning. Only 
use this option when the specific allergen cannot be found. 
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3.0 AHLTA Quick Tips 
CHCS II Version 837.2 contains over 3000 new MEDCIN findings in various specialties. In addition, 
pre-existing MEDCIN terms have been modified or retired. The descriptions on ICD-9 codes have also 
been corrected in the current release. Be aware of these updates when documenting the S/O and A/P 
sections of the encounter note. Users should be advised that while the text of a term may change, the term 
will not be removed from existing templates. If a term has been retired, it will not show up in the 
MEDCIN tree or in any templates that contained the specific term. 

 

Consults orders for civilian clinics can be documented through CHCS or CHCS II. For an outside consult, 
an electronic copy of the consult is printed from either system and the patient hand-carries the consult 
order to the Provider at the civilian clinic. In the CHCS II Order Consults screen, select the Civilian (DD 
2161) radio button for the Consulting Network, fill out the required fields, verify the Output Method as 
Print Only, and click Submit. The consult is documented and printed. Each site will handle this process 
slightly differently based on how they review and manage consults going out to the network. The DD 
2161 really should not be used at all unless a local site has a compelling reason to do so, since there is 
currently no intact means to track these. 

 

Demographic information cannot be updated in CHCS II. Demographic and third party insurance 
information may currently be viewed in CHCS II, but any required updates must be done in the respective 
existing (Legacy) systems. Clinical staff should follow the business rules established by the local MTF. 

 

If a new lab or radiology result is viewed and tossed or viewed and saved in the CHCS II New Results 
module, CHCS attaches an electronic signature to the result, indicating that it has been reviewed. If a 
result is discarded or forwarded in CHCS II, there is no write back to CHCS. This functionality is 
consistent with current CHCS business rules. In CHCS II, if you forward, the result now is on that 
receivers list in CHCS II, but will remain on the senders list in CHCS, until handled there as well. The 
Alerts section has a number of gaps in functionality between CHCS II and CHCS that are still evolving. 

 

MEDCIN quarterly updates do not impact terminology documented in previous encounters. The original 
text of the note will continue to be saved in the RTF (rich text file) for a previous encounter. If the 
previous encounter is used as a Copy Forward template and includes a retired MEDCIN term, that term 
will not display in the S/O module. If the text of the term has been modified, the updated text will display 
in the S/O module. 

 

CHCS II shall automatically default the Patient Status field for the current encounter in the E&M 
calculator to "Established" if the patient has been seen (kept an appointment) in the same clinic/specialty 
as the current encounter within the same MTF within the past 3 years. Otherwise, the Patient Status field 
shall default to "New”. Clinic/specialty refers to MEPRS code. MTF refers to DMIS ID. It is always a 
good practice to review this field prior to signing an encounter. 

 

When customizing the PE portion of S/O templates, the Current Vital Signs (Reviewed) MEDCIN term 
should always be included. When selecting this term, the user will receive credit for reviewing the 
patient’s current vital signs as part of the E&M code calculation. If no vital signs were documented for a 
specific encounter, this term should not be emitted into the note. 


